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ATTENTION:
MAC PEOPLE 

OF MARATHON!! 
We have a growing number of  people 

from the middle Keys who are traveling 
up to the meetings in Key Largo. If  you 
are interested in carpooling (and meet-
ing your fellow Marathon-area Mac 
devotées, contact Jody at gyokeres52@
gmail.com

Thursday
7PM

Key Largo Library Community Room, 
MM 101.4 Oceanside Tradewinds Plaza

Feb. 9 Beginner’s Circle
Come at 6:30 for Help for Mac Beginners:
Bring your laptop and your questions; for 
a half-hour prior to the main meeting we'll 
have experienced folks available to help !

Upper Keys Mac User Group Meeting

Allan Miller 

PC
Users 

Welcome

of Binary Engineering Inc.

Stay Safe
Online

 Allan Miller is the Owner and Chief 
Engineer at Binary Engineering, Inc., a 
Miami-based boutique computer 
consulting company specializing in 
making computer technology helpful 
and affordable to small business and 
individuals.  
 Check out his website, which is geared 
to help parents find safe material for 
their kids: wwwBinaryBackyard.com

“Information  
no one else 

tells you”

Coming in March:

Field Trip to the Apple Store at 
the Falls in South Miami!

 
Meet the staff, take the tour, 

learn how to access their 
services, like the Genius bar and 
classes. Fnd out what’s new and 

play with the toys! Stay tuned 
for more info - we are going to 

be carpooling.

Mac 101 with Jack & Chris
by Sue Beal

In January we welcomed All Keys ComputerGuy, which is 
Jack Buccellato and Chris Muller, with a presentation aimed 
at bringing new Mac owners on board. Just for starters, the 
presentation began with the coolest music and animation... 
showing one way having Macs improves our experience!

Jack began by talking about the Desktop 
and the Dock, giving newbies the defini-
tions to get started and understand the 
concepts so they can ask questions.

The Desktop is what you see when you 
first look at your Mac’s screen. It’s how you 
“get at” everything. Just like a real desk top, 
you have a surface, folders and documents, 
a trash can, and tools you use (stored in the 
Dock at the bottom of  the screen).

The Finder is the power behind every-
thing —- it’s the part of  the Operating 
System that you see and interact with. Oh, 
and it helps you find things! Duh!

The Finder allows you to open Windows 
into your Mac, and you can set a lot of  
different Preferences about how those 
windows look and act. The idea is, this is 
YOUR workspace, you can make it look 
any way you like!

At the left you see a Finder Window. If  
your window doesn’t look 
like this, click the bubble in 
the green oval and it will.

See the 4 buttons in the 
red oval? These control your 
views. More on that later.

The left column shows 
Places in your Mac. Click on 
any of  them and the content 
of  the Window changes to 
reflect what’s found there.

You can search within that 
Place by using the Search Bar 
(upper right, white area, with 
the magnifying glass.)
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So, how you see the information in the 
Window is your choice. Remember those 
View Buttons? From left to right they are: 
Icon View, List View, Column View and 
CoverFlow. 

Above is Icon View. You see the little file 
icons, or pictures. If  this were a file full of  
photos, you’d see little thumbnails of  the 
images. In the red oval is a slider bar; use 
this to make the icons bigger or smaller. 
At the bottom right (green circle) is a little 
triangle you can use to resize the Window. 
(This is on every Window.) The two folders 
at the bottom look different because they 
were Selected (clicked on) at the time the 
screen shot was taken.

Above is List View. You see a small icon next to the name of  
the folder or file. You also see more information, Date Modi-
fied, Size, Kind. (Use Command-J with any Window open to 
customize the columns for that Window.) See how the title of  
the Name column is highlighted in blue? That tells you this 
list is sorted on Name. See the tiny triangle (circled in red)? 
That tells you the sort is ascending. Click on it and it changes 
to descending. Click on any other title to sort by that attribute. 
Very handy when trying to find something you know is really 
large or recently worked on but you can’t remember what you 
called it. (Again, the two folders at the bottom were Selected.)

Above is Column View. This is Jack’s favorite because it’s a hybrid of  the other views, 
and it packs the most information in. It shows the contents listed in order, yet when 
you Select any one item, it shows you what’s inside, and so on, over to the end, which 
gives you the icon and information about the document. You see the hierarchy, and 
you always know how you got there.

And the final view (shown 
at the right) is CoverFlow. 
This is one that Apple bor-
rowed from iTunes, and 
while it may be cool to flip 
through your album covers 
this way, it’s not as useful in 
Finder. There’s an animated 
stack of  icons at the top and 
a List View below . You’ll 
have to give it a try and see 
what you think, who knows, 
you might love it!

How do you choose what suits you? Try them. You might 
find in some Windows you like one, and it others, another 
View works better for you. Play with it... you can’t break it!
File Operations

When you are creating documents, it’s important to know 
what the basic operations are, and where you put them, so you 
can find them again.

New - Open - Save - Save As ... these are basic things you can 
do with documents. The first three are self-explanatory. Save As 
saves another version under a new name (which you assign dur-
ing the Save As process). Someone noted that if  you aren’t sure 
where you just put something when you saved it, start to do a 
Save As (you don’t have to finish, you can cancel). But while the 
dialog box is open, it will tip you off  as to where it just saved the 
last document.

Jack cautions against using Auto-Save. This is an option in some 
programs, not all. He encourages users to learn to save and be in 
control at all times, to be responsible for their data. If  you make 
it a habit to save, you don’t need the program thinking for you.

How do you find documents after you have saved them?. First, 
make it a habit to pay attention when you do the first Save or Save 
As - so you see where it’s going to be stored. Some folks like to 

continued on page three
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IT’S DUES TIME
It’s dues time again! $25 

per year is our requested 
and voluntary donation... 
to keep UKMUG running 
smoothly. We ask for dues 
in Jan-Feb-Mar.

Please send a check 
payable to UKMUG at 219 2nd St., Key Largo, 
FL 33037 or hand it to Sue or John Thomas at 
the next meeting. 

Thank you to the ones who already paid, and 
to those who live far away and still support the 
club. You’re especially appreciated!

Last year, Harold Pinder asked me, “What 
do I get for my dues?” I answered that paying 
dues gets you nothing you can’t already get for 
free! Then he asked, “What does the group get 
for my dues?”

What a great question! 
With your dues, UKMUG:

- purchases and maintains equipment 
 for our presentations
- pays the hosting fee for our website
- provides refreshments at the meetings
- donates voluntarily to the Library 
 for the use of  the room
- puts ads in the papers occasionally to 
 draw in new people
- pays for duplicating the newsletter and 
 flyers to advertise meetings
- purchases the occasional movie or 
 software for demonstration,  or item for raffle
- gives a gift to everyone at the holiday 
 party (with help from donations by 
 Macintosh Systems Solutions and others)

So I guess the short answer is, with your sup-
port, we can keep everything going and provide 
a better experience for all.

UKMUG FINANCIAL REPORT
by John Thomas, Treasurer

save everything to the Desktop, then explic-
itly put it away in the proper place later. 
(Commnd-D in the Save Dialog box takes 
you there.) Some like to throw everything 
in the Documents folder and not worry so 
much about organizing.

If  you put documents on your Desktop 
... do make sure you put them away later. 
Leaving a lot of  files and folders on the 
Desktop can slow down your Mac, as the 
Desktop is “live.” The System is always 
looking at it and updating it. Big files also 
slow it down.

Cut - Copy - Paste ... these are com-
mands available to you almost all the time, 
in almost every App, and in the Finder. Cut 
and Copy are how you “grab” something 
to use later, like a paragraph of  text or an 
email address. Paste is how you deposit 
what you grabbed. 

Jack says to avoid Cut. The difference 
between Cut and Copy is with Cut the 
original goes away. With Copy, you leave 
the original and still grab a copy. Cut is 
dangerous!!

Oh, how do you actually use these? 
Select something, like a line of  text. Go 
to the Edit menu and select Copy, or use 
Command-C. Then position the cursor 
where you’d like to see the copied text go. 
Use the Edit Menu and select Paste, or use 
Command-V. (Paste is V because it’s next 
to C... and Command-P is always “Print.”)

You can even use Copy and Paste at the Finder 
level to duplicate files. Now that’s a new one to 
me ... I’m still learning too!! —Sue
Spotlight

Spotlight is a great way to find things on 
your computer. See the icon on the Menu 
Bar at the top of  your screen, all the way 
in the top right hand corner? It looks like 
a magnifying glass — that’s Spotlight. 
Click on it and start typing... anything 
you’re looking for. It will search emails, 
the content of  documents, the names of  
documents, even metadata, and it shows 
you a nicely organized results report as 
you type. Instantly!
Go Menu

Another quick way to get to some of  the 
Places in your computer is in the Finder’s 
Menu Bar - the Go Menu.
Userland (“Home”)

Jack calls the Home directory Userland, 
an apt name! This is where you create your 

Macintosh 101
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own space within the Mac.
It’s on your hard drive,  

in the Users folder, under 
your user name (your Mac 
can have multiple users, 
and there could be mul-
tiple usernames within the 
Users folder.) As you can see by the icon 
above, my username is “suebeal.”

All your “stuff ” is in there - your music, 
photos, videos, downloads, documents... 
anything you’ve set up as yours. Each user 
on the computer has all their stuff  in their 
own home folder, so each user’s area is 
kept separate and safe from the others.
Good Habits

Jack urges that you stay organized and 
put your stuff  in the right place. Not only 
is it easier to find, but it’s also easier to 
recover if  a professional needs to go in fix 
your computer.

The ultimate good habit is to back up. 
Copy important files and folders onto 
different media (burn to DVD, copy to 
a thumb drive or external drive... some-
thing apart from your computer). Give 
a copy to a trusted friend or relative to 
keep for you. The idea is, if  there’s a fire, 
hurricane or theft, the backup is nowhere 
near your computer, so you still have it 
after the disaster.  

The Cloud (iCloud, or any internet-
based storage service) may be used for a 
quick backup on the go, like when you 
want to save your photos in the midst 
of  a long vacation, but it’s not meant for 
huge amounts of  data, not for sensitive or 
private data, not for a long-term backup.

Backing up is the most important habit 
you need. I cannot stress this enough!!
Time Machine

Time Machine is an App built into the 
Mac to back up your stuff. You provide 
a hard drive and set up what you want 
backed and when, and it does it auto-
matically for you. Then, when you’ve 
accidently deleted something, you go into 
Time Machine (clock-like icon ion the top 
right of  your screen) and step back in time 
(cool interface!) to get it back. How far back 
it goes depends on how much stuff  and 
how much storage you have devoted to it.

Time Capsule works in conjunction 
with Time Machine to back up your 
mobile devices using a WiFi connection, 
you just have to have them on the same 
WiFi network.

continued on page four
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While both of  these are cool, convenient and easy... 
they still don’t cover you if  a power surge fries everything 
in your  house. So keep making those offsite backups!!
System Preferences

Under the Apple (top left corner of  your screen) is 
System Preferences. Open it and you see the tip of  the 
iceberg for customizing your Mac. This is where you 
hold the power to control your computing experience!!

Each line shows a group of  icons, and each icon opens 
up a preference window with multiple tabs, levels and 
settings to change your Mac. Jack says “play and learn.”

The top level is all about the look and feel of  your 
Mac. The second level is how  you set up preferences 
about your hardware devices. The third line - Internet/
Wireless settings. Be careful when you mess with these, 
there are consequences! The next level 
has the System settings. Accounts is par-
ticularly useful, this is where you set up 
your Mac for multiple users, keeping their 
workspaces separate. Parental Controls 
holds good settings if  you have little ones 
using your machine. Software Update sets 
the frequency of  automatic checking for 
updates. Speech is fun to play with. And 
more... 
Installing & Removing Apps

When you download an App, you get a 
file with a .DMG extension. This stands 
for “disk image” and if  you double click it, 
it will open as icon that looks like a hard 
drive. Think of  it as a virtual hard drive 
(it’s temporary.) Open that and you see the 
installer icons. Most programs these days 
install simply by dragging the App icon 
to the Applications folder icon. ( They 
usually put an alias of  your Applications 
folder right next to the App, with an arrow. 
It couldn’t be easier! )

If  you want the new App to appear in 
your dock, open the Applications folder 
and drag the new App’s icon down to the 

dock. (Do this from the Apps folder, not 
the .DMG one!!) You can trash the .DMG 
and the virtual hard drive after installing.

A few of  the pricier/more complex Apps 
require you to run an installation program, 
because their process is more complex and 
needs to put things in different areas of  
your machine.

To uninstall, drag the App from your 
Applications folder into the Trash Can. 
To get it out of  your Dock, simply drag 
it out a little way and drop it. You’ll see 
it go “poof!”
Ejecting a Disk

This is the Eject Symbol. 
Press the key on the keyboard 
and hold it for 3 seconds, and 
your disk or disk  drive try will pop out. 
Or, you can select the disk by clicking on 
its icon, then go to the File Menu and 
select Eject. 

If  a disk gets stuck and Eject doesn’t 
work, select Restart from under the Apple 
and then while your Mac restarts (after 
the powerdown), hold your mouse button 
down to force an eject.

Ejecting a Thumb Drive

Ejecting a thumb drive or memory 
stick is similar ejecting a disk - drag the 
icon to the trash, or eject it using the File 
Menu. But one important note - wait a 
few seconds before you actually pull the 
drive out of  the USB port. Make sure no 
lights are flashing on it. Be patient!! If  
you pull it out too soon you are likely to 
lose all the data it holds.

Never unplug a thumb drive without 
first Ejecting it. Not even if  nothing is 
being done with it. Never!
Ejecting a Camera

After downloading your photos, power 
the camera off. Let it finish its processing 
and shut down. Then disconnect it.
Wireless vs. Wired

Jack said that there are a lot of  cool 
ways out there to use Bluetooth and wire-
less devices,but some are just not worth 
the trouble. Choose carefully. A wireless 
mouse, like the Magic Mouse, eats batter-
ies like crazy. If  a wireless device is giving 
you trouble, try plugging it in... sometimes 
wires just work better.

Great uses for wireless devices are Apple 
TV and AirPlay. On the other hand, wired 
Internet is 2-3 times faster than wireless.
Synching

Synching is the process of  keeping all 
your devices synchronized so that the 
contacts you have on your iPhone match 
those on your laptop, and so on. You can 
sync wirelessly through iCloud or Mobile 
Me. Or you can actually plug in and do it 
with a wire. It works either way, but one 
big caution: DO NOT SYNC EMAIL 
THROUGH ICLOUD. If  you do, you’ll 
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end up with multiple copies of  each email, 
and it will drive you crazy! Email is already 
covered in its own “cloud.”
POP and IMAP

There are two email protocols, POP and 
IMAP. POP stands for Post Office Protocol 
and IMAP stands for Internet Message Ac-
cess Protocol. If  you have multiple devices 
accessing email, you want to use POP. POP 
can be set up two ways - in one it sucks the 
mail down from the server and deletes the 
copy from the server. The mail then lives 
on the machine it got pulled onto (yours). 
The second one leaves a copy on the server, 
so you can read it on your other devices. 

IMAP is the default protocol, for Apple 
machines. It means every device looks at 
what’s on the server, but the mail actually 
stays on the server and does not get down-
loaded to any one device. All devices see 

the same thing. 
Apple Mail Pointers

In Apple’s Mail program you can set up 
as many accounts as you like. You can pull 
your Google or Yahoo mail into Mail and 
manage it there. Jack suggests you set up 
at least one extra Mail account - for junk 
mail. Keep one close - for friends and family, 
and use the junk one for when you have to 
enter something on the Internet.
A final word on Lion

Jack, along with many in the industry, 
does not encourage anyone to update 
to Lion unless they absolutely have to. 
Quicken and Quickbooks are still not com-
patible, and there are still a lot of  problems 
with it. “If  it ain’t broke, don’t fix it.” is his 
official word on the subject!

We thank Jack and Chris for a very infor-
mative evening. Even this seasoned Mac user 
learned a few new things. We look forward to 
having them back again! —Sue

http://www.sadanduseless.
com/2012/01/famous-paintings-

improved-by-cats/

Famous paintings 
improved by cats

submitted by Denise Malefyt

Beware AT&T Emails
by Sue Beal

One of  our members lost all of  his 
contacts and stored emails - everything! 
He couldn’t get it back, and here’s how it 
happened...

He got an innocent-looking email from 
AT&T... it said that because he had so 
many unused emails they wanted him to 
verify his  email and password. In his own 
words, “Duh, I fell for it.”

Next all of  his contacts (including me) 
got an email saying he was on vacation 
in Spain and got mugged... yadda yadda. 
When I got it I knew it wasn’t him. A lot 
of  these emails have been around, we’ve 
all seen them.

But at the same time, he discovered his 
address book and all of  his emails were 
gone. He went to Apple and Bellsouth for 
help, but neither could help him.

So please, please --- be aware of  this 
and be highly suspicious of any request 
for info from Bellsouth or AT&T. (I have 
seen them from PayPal and banks too.) Or 
from anybody for that matter. Don’t reply. 
Go to their website independently (don’t 
click any links in the email) and see if  they 
are really asking for something. Generally, 
they aren’t and you’ll save yourself  a world 
of  hurt!!
Attention Bellsouth users:

Another new phishing scam is targeting 
BellSouth users via their e-mail accounts. 
This is the perfect set up for the scammers 
and with you being a trusting BellSouth 
user, they can easily get the information 
they want  out of  you. 

If  you’re caught by this scam, you will 
receive an e-mail that looks like it’s from 
BellSouth (support@bellsouth.net), ask-
ing you to verify your account with them. 
When you click on the link, you’re then 
asked to send a copy of  your credit card to 
another link within the e-mail. They then 
go on to tell you they need this informa-
tion in order to update your account. And 
here’s an even bigger kicker: the scammers 
also tell you they need this information 
so that they can keep you protected from 
other scams and identity theft. How clever!

The e-mail looks very legit and it’s put 
together in a nice fashion, so it’s easy to fall 
for. Then you find out your credit card info 
has been stolen. BellSouth will never ask 
you for that kind of  information through 
an e-mail. Delete the e-mail.



Macaholics UNANIMOUS Page 6

The Official Newsletter of the Upper Keys Macintosh Users Group August 1993                   Volume 1, Issue 1

is the official newsletter of the

Upper Keys Mac Users Group
A nonprofit organization devoted to the use (and 
sometimes abuse) of the Macintosh computer. 
Subscriptions are $25.00 for one year. Contents © 
1993 - 2011 by the Upper Keys Macintosh Users 
Group except where noted. All other rights reserved. 

219 Second St. • Key Largo FL 33037
(305) 451-4601 • ukmug@bellsouth.net

VISIT TODAY!
http://ukmug.pbworks.com/

UKMUG’s Collaborative Website

Post questions 
and requests for help
Post tips and tricks

Post your favorite links
Check on upcoming meetings

Download our newsletters & more!

FREE OS X CLASSES
The Apple Store at the Falls has free OS X 

classes every  Saturday from 9-10 am!  They 

also have one-on-one training, workshops 

and the Genius Bar. Call for more info:

Apple Store at The Falls
305-234-4565 

8888 SW 136th Street
Miami, FL 33176  
Mon-Sat:10-9:30pm
Sun: noon-7pm

http://www.apple.com/retail/thefalls

Come at
6:30 for the

Beginners Circle:
Bring your laptop 

and your questions 
at 6:30, and for a half-hour
prior to the main meeting 

we'll have experienced 
folks available to help, 

one on one, or in 
small groups.

FREE CLASSES IN KEY WEST!
Macintosh™ Systems Solutions has a free class 

almost every Saturday morning at the store in Key 
West! Visit them at 1001 Truman Avenue at the cor-
ner of  Grinnell. They offer a wide range of  classes 
for new and experienced Mac users. Stop by for all 
your Apple sales, service, and training needs, or call 
293-1888.

Did you see that picture of you, taken

at the last meeting? 

http://ukmug.pbworks.com/

HELP A NEWBIE!
Every meeting we get a couple of  new 

users who have a lot of  questions and 
anxiety about learning to use their Macs. 
Introduce yourself  to an unfamiliar face. 
Even if  you don’t think you're an expert 
(who does?), you probably know a few 

things that can help them! 

It’s what UKMUG is about!

dummies.com 
is a great place for
 useful and brief          

Mac Tips and Tricks! 
Check it out!

Color Copies •  Large or Small Orders
Rack Cards • Business Forms & Checks • Brochures

Business Cards • Letterhead • Envelopes

Signs and Banners • Multi-Part Forms • RX pads 

Posters • Rubber Stamps • Graphic Design

305-664-1002 
81933 Overseas Hwy., Islamorada

printsourcekeys@yahoo.com

MU Classifieds •  MU Classifieds

Got Stuff  for Sale or Giveaway? Need Something?
Email ukmug@bellsouth.net and I’ll post it here.

Free 
Manual 
for 
Newbies 
Mac Users!

This 69-page PDF guide 
(from Makeuseof.com) sup-
plies you with numerous tips, 
tricks and free applications. 

Download it from http://
ukmug.pbworks.com/

Printer for Sale “Newish”
HP Photosmart Premium Fax C309 series Pur-
chased for $300 , Nov. 2009.   There is absolutely 
nothing wrong w/it -- it was used as a personal 
home printer.   I was pretty upset when my hus-
band replaced it w/a newer model about a year 
later (because it could air print) so this printer is 
just sitting around.  $150, OBO. Please contact 
Lisa at n8urgirl@aol.com

Dear iPhone,

Please stop spell checking 
all of my rude words into 
nice words.

You piece of shut.

Sincerely,
Every iPhone User


